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1 PC-Fax TX

1.1 Outline of PC-FAX TX function

The general facsimile sends and receives paper documents. In contrast, the PC-Fax TX function sends a doc-
ument data on a Windows PC as if it was printed on this machine.

This is well suited for an environment where you handle a large number of data files because it is not neces-
sary to prepare paper documents to send faxes.

The fax destinations can be set using the Address Book already stored on this machine. Also, you can create 
a phone book and control the destinations on the PC.

Tips
- The Fax Kit is required to use the PC-Fax TX function.
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1.2 System Environment Requirements

Before using the PC-Fax TX function, you must first install the fax driver software on your PC.

If you use the installer software to install the fax driver, the machine on the network or the machine connected 
via USB interface can be detected automatically. You will be able to easily install the fax driver.

Item Specifications

Operating system Windows XP Home Edition (SP1 or later) *1
Windows XP Professional (SP1 or later) *1
Windows Server 2003 Standard Edition (SP1 or later)
Windows Server 2003 Enterprise Edition (SP1 or later)
Windows Server 2003 R2 Standard Edition
Windows Server 2003 R2 Enterprise Edition
Windows XP Professional e64 Edition
Windows Server 2003, Standard e64 Edition
Windows Server 2003, Enterprise e64 Edition
Windows Server 2003 R2, Standard e64 Edition
Windows Server 2003 R2, Enterprise e64 Edition
Windows Vista Business *2
Windows Vista Enterprise *2
Windows Vista Home Basic *2
Windows Vista Home Premium *2
Windows Vista Ultimate *2
Windows Server 2008 Standard *2
Windows Server 2008 Enterprise *2
Windows Server 2008 R2 Standard
Windows Server 2008 R2 Enterprise
Windows 7 Home Basic
Windows 7 Home Premium *2
Windows 7 Professional *2
Windows 7 Enterprise *2

Windows 7 Ultimate *2
*1 The operating environment required for the installer is SP2 or later.
*2 Supports 32-bit (e86)/64-bit (e64) environment.

CPU Any processor of the same or higher specifications as recommended for 
your operating system

Memory Memory capacity as recommended for your operating system
The memory space must be enough for the OS and applications used.

Drive DVD-ROM drive
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1.3 Printer cable connection to this machine

The printer cables are connected to each port on this machine.

No. Port Description

1 Ethernet port (1000Base-
T/100Base-TX/10Base-T)

Use the LAN cable to connect this machine to the network. This 
machine supports the 1000Base-T, 100Base-TX and 10Base-T 
protocols.
The TCP/IP (LPD/LPR, IPP and SMB) protocols and Web serv-
ices are supported.

2 USB port Use a USB interface cable for USB connection.
Use a type A (4-pin, male) or type B (4-pin, male) USB cable. A 
USB cable measuring three meters or less is recommended.

2

1
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2.1 Overview 2

2 Preparation for PC-Fax TX (via network connec-
tion)

2.1 Overview

Before using the PC-Fax TX function, you must install the fax driver software on your PC.

This section explains the preparatory procedure for enabling the PC-Fax TX function using the installer sup-
plied with this machine.
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2.2 Before installing the fax driver (for the administrator)

Preparation flow

Before installing the printer driver software on the PC, you must first set up this machine to enable PC-Fax 
TX via the network connection.

1 Connect this machine to the network.

% Check the LAN cable for connection.
% Check the network settings.
Ensure that this machine has an IP address assigned to it.

2 Set up the PC-Fax operating environment.

% When using the Normal printing (at port 9100)
Make sure that the RAW port number has been set. (Usually, you can use the default settings.) Use Nor-
mal Printing (Port 9100) unless otherwise specified by the administrator.
% When using the Internet Print (IPP)
Check the IPP operating environment. (Usually, you can use the default settings.)
% When using the Secure Print (IPPS)
Set up the IPPS operating environment. Establish the communication with SSL encryption between this 
machine and the PC.

3 Preparation has finished.

Check the LAN cable connection

Ensure that a LAN cable is connected to the LAN port of this ma-
chine.

Check the network settings

Ensure that this machine has an IP address assigned to it. Tap [Utility] - [Device Information], and check that 
an IP address is displayed.

d Reference

If no IP address is displayed, you need to set up the network. For details, refer to [User's Guide: Web Man-
agement Tool].
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Set up the PC-Fax TX environment

Set up the operating environment according to the method of printing.

How to print If the printing method is not specified before installation, Normal Printing (Port 9100) is selected 
for printing. Use Normal Printing (Port 9100) unless otherwise specified by the administrator.

Tips
- If you are using Windows Vista/7/Server 2008/Server 2008 R2, you cannot setup the Secure Print (IPPS) 

using the installer.
- If you are using Windows XP or Server 2003 in an IPv6 environment, you cannot setup the Secure Print 

using the installer.
- The Internet Print (IPP) is not supported in the IPv6 environment.

Enabling device information to be obtained from the fax driver

Disable the OpenAPI authentication function. (Usually, you can use the default settings.)

If device information collection from the fax driver is enabled, the fax driver automatically collects the infor-
mation such as optional device attachment and authentication settings.

For details on how to setup, refer to [User's Guide: Print Operations].

Related setting (for the administrator)
- You can use a password to restrict the ability to obtain device information from the printer driver (de-

fault: [No]). For details, refer to [User's Guide: Print Operations]. 
To configure settings, select [Utility] - [Administrator Settings] - [Printer Settings] - [Assign Account to 
Acquire Device Info].

How to print Description

Normal printing (Port 9100) Make sure that the RAW port number has been set. (Usually, you can use 
the default settings.)
The settings configuration method is explained using Web Connection. 
For details, refer to [User's Guide: Web Management Tool].

Internet Print (IPP) Check the IPP operating environment. (Usually, you can use the default 
settings.)
The settings configuration method is explained using Web Connection. 
For details, refer to [User's Guide: Web Management Tool].

Secure Print (IPPS) Set up the IPPS operating environment. Establish the communication with 
SSL encryption between this machine and the PC.
The settings configuration method is explained using Web Connection. 
For details, refer to [User's Guide: Web Management Tool].
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2.3 Quick installation of the fax driver

Installation flow

The following explains the system setup flow to enable PC-Fax TX from the PC.

1 Prepare the fax driver.

% Prepare the DVD-ROM disk.
% Check the operating system (OS) version that supports the fax driver.
Ensure that the operation requirements of the fax driver are satisfied by the PC where you install the fax 
driver.

2 Install the fax driver on the PC.

% Install the fax driver on the PC using the installer.
Mount the DVD-ROM disk on the drive, and install the software by following the on-screen instructions.
% Carry out a test print.
Carry out a test print and verify that it is acceptable.

3 Preparation has finished.

Check the operating system (OS) version that supports the fax driver

For details on the PC's Operating System (OS) that supports the fax driver, refer to page 1-4.
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Installation procedure

Install the fax driver on the PC by using the installer.

0 You need to have the administrator privileges to perform this task.
0 Use the DVD-ROM.

1 Mount the DVD-ROM disk on the DVD-ROM drive of the PC.

% Make sure that the installer starts, and then go to Step 2.
% If the installer does not start, open the printer driver folder on the DVD-ROM, double-click [Set-

up.exe], and then go to Step 3.
% If the [User Account Control] screen appears, click [Continue] or [Yes].

2 Click [Printer Install].

3 Read the license agreement, then click [AGREE].

4 Select [Install printers/MFPs], then click [Next].

Connected printers are detected.
% For Windows Vista/7/Server 2008/Server 2008 R2, you can select [Preference for IPv4] or [Prefer-

ence for IPv6]. The address has the preference when detected in both IPv4 and IPv6.

5 Select this machine, then click [Next].

% If this machine is not detected, restart it.
% You do not need to change the printing method from [Normal Printing] (Port 9100) unless otherwise 

specified by the administrator.
% As a printing method, you can select [Normal Printing], [Internet Printing] (IPP), or [Secure Printing] 

(IPPS).
% Among the connected printers, only the target model is automatically detected and displayed. If 

multiple target models are displayed, check the IP addresses.
You can check the IP address of this machine in the screen that is displayed by tapping [Utility] - 
[Device Information].

% If the connection to this machine cannot be recognized, it is not displayed in the list. In such a case, 
select [Specify the Printer/MFP Except for the Above.(IP Address, Host Name...)], and manually 
specify the IP address and host name of this machine.

6 Select the fax driver box, then click [Next].

7 Check the components to be installed, then click [Install].

8 Change the printer name or print a test page if necessary, then click [Finish].

The fax driver has been installed on the PC.

d Reference

Be sure to initialize the fax driver after you have installed it. For details, refer to page 2-8.

Settings Description

[Review] Displays the installed components for checking.

[Rename Printer] Changes this machine name if necessary.

[Property] Sets the optional operating environment of this machine. For details, refer 
to page 2-8.

[Print Setting] Changes the default print settings of this machine if necessary. For details, 
refer to page 2-8.

[Print Test page] Prints a test page to check the normal data transfer if necessary.
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2.4 Initialize the fax driver

Set the optional operating environment of this machine

If you are using this machine for the first time, ensure that optional device installation and authentication set-
tings have been correctly reflected on the fax driver.

1 Open the [Properties] screen of the fax driver.

% For details on how to open the [Properties] screen, refer to page 6-3.

2 Open the [Configure] tab, and check the optional device installation and authentication settings on this 
machine.

% Because the [Auto] of [Obtain Settings...] is enabled by default, the current information of this ma-
chine is obtained automatically and reflected on the [Device Option].

% If the [Auto] of [Obtain Settings...] is disabled and if you click [Obtain Device Information], the current 
information of this machine is obtained and reflected on the [Device Option].

% If communication with this machine fails, set the [Device Option] manually. Select an item to change 
from the list, and set a value in the [Setting].

3 Click [OK].

Change the default print settings

You can change the default print settings of the fax driver if necessary.

For example, if you set to send the initial value with page combination, you can reduce the number of pages 
printed at the destination. We recommend that you change the default settings to suit your environment.

1 Open the [Printing Preferences] screen of the fax driver.

% For details on how to open the [Printing Preferences] screen, refer to page 6-10.

2 Change the print settings, then click [OK].

Your changes apply to the PC-Fax TX in all application software.

d Reference

The fax driver has the function to save favorite settings. For details, refer to page 4-13.
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3 Preparation for PC-Fax TX (via USB connection)

3.1 Overview

Before using the PC-Fax TX function, you must install the fax driver software on your PC.

This section explains how to prepare PC-Fax TX, using the installer supplied with this machine.
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3.2 Quick installation of the fax driver

Installation flow

The following explains the system setup flow to enable PC-Fax TX.

1 Prepare the fax driver.

% Prepare the DVD-ROM disk.
% Check the operating system (OS) version that supports the fax driver.
Ensure that the operation requirements of the printer driver are satisfied by the PC where you install the 
fax driver.

2 Install the fax driver on the PC.

% Set up the software installation on the PC.
If the PC is running on Windows 7 OS or the Windows Server 2008 Revision 2, you need to change the 
PC settings in advance.
% Install the fax driver on the PC using the installer.
After connecting the USB cable, mount the DVD-ROM disk on the drive, then install the software by 
following the on-screen instructions.
% Carry out a test print.
Carry out a test print and verify that it is acceptable.

3 Preparation has finished.

Check the operating system (OS) version that supports the fax driver

For details on the PC's Operating System (OS) that supports the fax driver, refer to page 1-4.

Changing the installation settings (Windows 7 or Windows Server 2008 R2)

If the PC is running on Windows 7 OS or Windows Server 2008 Revision 2, change the current PC settings 
before installing the fax driver.

1 From the Start menu, click [Control Panel] - [System and Security] - [System].

2 Click [Advanced system settings] on the menu to the left.

The [System Properties] screen appears.

3 In the [Hardware] tab, click [Device Installation Settings].

4 Select [No, let me choose what to do], select [Never install drive software from Windows Update.], then 
click [Save Changes].

% When you have finished installing the printer driver, restore the selection for the options in Step 4 to 
[Yes, do this automatically (recommended)].

5 Click [OK] to close the [System Properties] screen.
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Installation procedure

Install the fax driver on the PC by using the installer.

0 You need to have the administrator privileges to perform this task.
0 Use the DVD-ROM.

1 Connect a USB cable to the USB port of this machine.

% If a wizard screen appears to add new hardware, click 
[Cancel].

2 Mount the DVD-ROM disk on the DVD-ROM drive of the PC.

% Ensure that the installer starts, then go to Step 3.
% If the installer does not start, open the printer driver folder on the DVD-ROM, double-click [Set-

up.exe], then go to Step 4.
% If the [User Account Control] screen appears, click [Continue] or [Yes].

3 Click [Printer Install].

4 Read the license agreement, then click [AGREE].

5 Select [Install printers/MFPs], then click [Next].

Printers being connected via USB ports are detected.

6 Select this machine, then click [Next].

7 Select the fax driver box, then click [Next].

8 Check the components to be installed, then click [Install].

9 Change the printer name or print a test page if necessary, then click [Finish].

The fax driver has been installed on the PC.

d Reference

Be sure to initialize the fax driver after you have installed it. For details, refer to page 3-6.

Settings Description

[Review] Displays the installed components for checking.

[Rename Printer] Changes this machine name if necessary.

[Property] Sets the optional operating environment of this machine. For details, refer 
to page 3-6.

[Print Setting] Changes the default print settings of this machine if necessary. For details, 
refer to page 3-6.

[Print Test page] Prints a test page to check the normal data transfer if necessary.
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3.3 Initialize the fax driver

Set the optional operating environment of this machine

If you are using this machine for the first time, apply the optional device installation and authentication set-
tings to the fax driver.

1 Open the [Properties] screen of the fax driver.

% For details on how to open the [Properties] screen, refer to page 6-3.

2 Open the [Configure] tab, and check the optional device installation and authentication settings on this 
machine.

% If you are using Windows Vista/7/Server 2008/Server 2008 R2, [Auto] under [Obtain Settings...] is 
enabled by default. Thus, the information of this machine is automatically obtained and applied for 
[Device Option].
If the [Auto] of [Obtain Settings...] is disabled and if you click [Obtain Device Information], the current 
information of this machine is obtained and reflected on the [Device Option].

% If you are using Windows XP/Server 2003, set the option manually using [Device Option]. Select an 
item to change from the list, and set a value in the [Setting].

3 Click [OK].

Change the default print settings

You can change the default print settings of the fax driver if necessary.

For example, if you set to send the initial value with page combination, you can reduce the number of pages 
printed at the destination. We recommend that you change the default settings to suit your environment.

1 Open the [Printing Preferences] screen of the fax driver.

% For details on how to open the [Printing Preferences] screen, refer to page 6-10.

2 Change the print settings, then click [OK].

All the changes you made will be applied when executing PC-Fax TX using any type of application soft-
ware.

d Reference

The fax driver has the function to save favorite settings. For details, refer to page 4-13.
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4 PC-Fax TX

4.1 Transmission flow

1 Open document data using the application software. From the [File] menu, select [Print].

2 Check that the fax driver of this machine is selected in [Printer Name] (or [Select Printer]).

% The [Print] dialog box differs depending on the application.

3 Set a range of pages to send.

4 Click the [Properties] (or [Preferences]) and change the print settings of fax driver if necessary.

% For details on the print settings, refer to page 6-3.
% The print settings you have changed here return to the default values when you exit the application 

software. For details how to change the default print settings, refer to page 2-8.
% The fax driver provides Favorite Setting to enable quick selection of frequently used print settings. 

For details, refer to page 4-13.

5 Click [Print].

The [FAX Transmission Popup] screen opens.

6 Set the recipient name and fax number.

% When you select a recipient from the Address Book of this machine, click [Add from Address 
Book...]. For details, refer to page 4-8.

% When you select a recipient from the Phone Book of the PC, click [Add From Phone Book...]. Refer 
to page 4-7.

% Set the fax transmission function and add a cover page to the fax if necessary. For details, refer to 
page 4-11.

7 Click [Add Recipients].

% When you send a fax to multiple destinations, repeat Steps 6 and 7. You can register up to 100 re-
cipients.

% To cancel a recipient, select it, then click [Delete From List].



Transmission flow4
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8 Click [OK].

The document data are faxed via the machine.
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4.2 The [FAX Transmission Popup] screen

4.2.1 Opening the [FAX Transmission Popup] screen

From the [FAX Transmission Popup] screen, you can select fax recipients and change the fax transmission 
conditions. You can open the [FAX Transmission Popup] screen as follows:

1 Open document data using the application software. From the [File] menu, select [Print].

2 Check that the fax driver of this machine is selected in [Printer Name] (or [Select Printer]).

% The [Print] dialog box differs depending on the application.

3 Click [Print].

The [FAX Transmission Popup] screen opens.
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4.2.2 The [FAX Transmission Popup] screen options

Settings Description

[Name] Enter a recipient name (using up to 80 characters).

[FAX Number] Enter the destination fax number (using up to 38 digits, with available sym-
bols being a hyphen ( ), #, *, P, and T).
When you send a fax to a foreign country, enter the country code before 
the fax number.

[ECM] Uncheck the ECM box to cancel the Error Correction Mode (ECM).
The ECM is an error correction mode defined by the ITU-T (International 
Telecommunication Union - Telecommunication Standardization Sector). If 
fax machines support the ECM, they check for fax data errors while com-
municating with each other. Image disturbances due to telephone line 
noise can be suppressed.
This machine uses the ECM based communication by default. However, if 
the noise is high, the communication may take a little longer than the com-
munication without using ECM checking.
If you need to shorten the communication time, cancel the ECM checking 
and send a fax.

[International Transmis-
sion Mode]

Select the [International Transmission Mode] check box to send a fax to a 
foreign country.
The Overseas TX Mode function reduces the transmission speed (the infor-
mation transfer speed) for sending a fax. This is useful when sending a fax 
to an area where the communication status is poor.

[V.34 Mode] Clear the [V.34 Mode] check box to release the V.34 protocol mode.
The V.34 protocol is used for Super G3 fax communication. This can short-
en the communication time and cut the communication cost because a 
single page of size-A4 document can be sent within approximately 3 sec-
onds.
This machine uses the V.34 protocol communication by default. This ma-
chine cannot use the Super G3 mode communication if this machine or the 
destination fax is not connected to the PBX line or if the fax line speed is 
limited. If so, cancel the V.34 mode communication.

[Add Recipients] When a recipient is entered in the [Recipients Entry] field, this button adds 
it to the [Recipient List] list.

[Add from Address Book...] Click this button to select a recipient from the Address Book of this ma-
chine.
For details, refer to page 4-8.

[Add From Phone Book...] Click this button to select a recipient from the Phone Book of the PC. For 
details, refer to page 4-7.

[Register To Phone Book] Click this button to register the [Name] and [FAX Number] in the Phone 
Book. This entry is stored in the [Simple Entry] folder of the Phone Book. 
For details on how to register it, refer to page 4-15.
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4.2.3 Select a recipient from the Phone Book

You can quickly select a PC-Fax recipient from the Phone Book being controlled on your PC.

0 The recipient registration is required in advance. For details on how to register it, refer to page 4-15.

1 From the [FAX Transmission Popup] screen, select [Add From Phone Book...].

2 Select [Personal List] or [Group] from the list on the left side of the Phone Book, and display the desired 
recipient in the [Personal Information] list.

% When you click [Search...], you can use a conditional search. The search results are displayed in the 
[Personal Information] list. For details, refer to page 4-17.

3 Select a recipient name from the [Personal Information] list, then click [Add Recipients].

% You can register up to 100 recipients.
% To cancel a recipient, select it, then click [Delete].
% If the recipient is already registered in a Group, select the group name, then click [Add Recipients]. 

All members are added to the [Recipient List].

4 Click [OK].

The screen returns to the [FAX Transmission Popup] screen.

[Fax Mode Setting De-
tails...]

Click this button to set the fax TX functions such as timer transmission and 
F-code transmission. For details, refer to page 4-11.

[FAX Cover Sheet] Select this check box to add a cover sheet to the fax when you send it. 
Click the [Settings] button to set up the cover sheet details. For details, re-
fer to page 5-3.

Settings Description
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4.2.4 Select a recipient from the Address Book of this machine

Select a PC-Fax recipient from the Address Book stored on this machine.

0 You can use the PC-Fax transmission only when this machine can communicate with the PC through 
the network.

0 The recipient must be registered in the Address Book in advance. For details on how to register it, refer 
to [User's Guide: Fax Operations].

1 From the [FAX Transmission Popup] screen, select [Add from Address Book...].

2 Select [Address Book List] from the list at the left of screen, and display the desired recipient in the [Ad-
dress Book] list.

% Click the [Get Addr. Info] button, and this machine starts communication and obtains the recipient 
information.

% When you click [Search...], you can use a conditional search. The search results are displayed in the 
[Address Book] list.

3 Select the recipient from the [Address Book] list, then click [Add Recipients].

% You can register up to 100 recipients.
% To cancel a recipient, select it, then click [Delete From List].

4 Click [OK].

The screen returns to the [FAX Transmission Popup] screen.
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4.2.5 Search for a recipient from LDAP Server

If you are using the LDAP server or the Active Directory of Windows Server, you can search for a recipient on 
the server.

0 The LDAP server must be registered in advance to enable recipient search from the server. For details 
on how to register it, refer to page 6-8.

1 From the [FAX Transmission Popup] screen, select [Add From Phone Book...].

2 Select the LDAP server for search from the left list, then click [Search].

3 Set the search conditions in the [Basic] tab or [Advanced] tab, then click [Search Now].

% The [Basic] search displays recipients which meet any of search conditions. Enter characters to 
search, then click [Search Now].
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% The [Advanced] search displays the recipient which matches all of search conditions. Select the 
[Search Item] and [Condition]. Then, enter characters to search, then click [Add Condition]. Specify 
multiple search conditions if necessary, then click [Search Now].

The search result is displayed.

4 Select the recipient from the search result, and add it to the Recipients list.
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4.2.6 Set the fax transmission functions

From the [FAX Transmission Popup] screen, select [Fax Mode Setting Details...] and you can set up the Fax 
transmission functions.

Tips
- When you use the timer transmission, check that the clock time of the PC matches the clock time of 

this machine. If the clock time of this machine has already passed the specified send time, the fax is 
sent in the next day.

Settings Description

[Print Recipient File] Select this check box to send a fax and print it at the same time.
You can also set this option using the [FAX] tab of [Printing Preferences] 
screen.

[Timer Send] Select this check box to set a time to send a fax. The fax is automatically 
sent at the specified time.
• [Reflect Current Time]: Reflects the current time of the PC onto the 

[Send Time].
You can also set this option using the [FAX] tab of [Printing Preferences] 
screen.

[SUB Address] When you use the F-code TX function, select this box and enter the desti-
nation box number (using up to 20 digits).
You can also set this option using the [FAX] tab of [Printing Preferences] 
screen.

[Sender ID] When you use the F-code TX function, select this box and enter the pass-
word for the destination box (using up to 20 digits, with available symbols 
being # and *).
You can also set this option using the [FAX] tab of [Printing Preferences] 
screen.
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4.2.7 Add a cover sheet

When you open the [FAX Transmission Popup] screen and select the [FAX Cover Sheet], you can add a cover 
sheet to the fax to be sent.

When you click [Settings...], you can change the cover sheet. For details on how to change it, refer to 
page 5-3.

Tips
- If the PC is running on Windows Vista x64, Windows 7 x64, Windows Server 2008 x64, or Windows 

Server 2008 Revision 2, you cannot change the cover sheet from the [FAX Transmission Popup] screen. 
Use the [FAX] tab of the fax driver for the change.
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4.3 Call the frequently used settings

You can save the current print settings in the Favorite folder and quickly recall them when you send a fax.

Once saved, you can quickly select the desired print settings from the list even if the settings were made by 
multiple tabs.

The following explains the procedure of favorite print setting.

1 Open the [Print Preferences] screen, and set the favorite print conditions in this screen. 

2 Click [Add...].

% When you edit an existing setting, select its name from the [Favorite Setting], then click [Edit].

3 Enter the names of favorite settings.

% Set an icon, a comment and call options for the favorite settings if necessary.

Settings Description

[Name] Enter the names of favorite settings.
Use names that can easily be identified.

[Icon] Assign an icon to the favorite settings if necessary.

[Sharing] Select this check box to share the favorite settings with other users.

[Comment] Enter a comment to the favorite settings if necessary.
The comment is displayed when you place the mouse cursor over the fa-
vorite in the Favorite Setting list.

[Restore Items] The favorite settings may contain the size of original and other options 
which are determined only when fax is sent. When you call the favorite set-
tings, these options are not set by default. However, you can define these 
options in the favorite settings if necessary.
Select the check box of items to be retrieved.
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4 Click [OK].

The favorite print settings are registered. You can select the favorite settings from the [Favorite Setting] 
list when sending the fax.
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4.4 Managing the recipient information by the PC (using the Phone 

Book)

Register recipients in the Phone Book

If you have registered the frequently calling recipients in the Phone Book, you can quickly call the recipient 
when sending a fax. Use the [FAX] tab of the fax driver to add recipients to a phone book.

When you use the Phone Book for the first time, create a Phone Book file. When you use the Phone Book for 
the second or other times, the previously used Phone Book file is opened automatically. When you change 
the contents of Phone Book, the Phone Book file is overwritten with your changes.

1 In the [FAX] tab, click [Phone Book Entry...].

2 Select [Personal List] from the list at left, then click [Add New...].
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3 Enter the recipient information.

4 Click [OK].

The personal information is registered and displayed under [\Phone Book\\Personal List]. If you have 
selected groups for the recipient, it will be displayed in the groups list.

Settings Description

[Name] Enter a recipient name (using up to 80 characters).
When you set the recipient name, you can add a title to this name.

[FAX Number] Enter the destination fax number (using up to 38 digits, with available sym-
bols being a hyphen (-), #, *, P, and T).
When you send a fax to a foreign country, enter the country code before 
the fax number.

[Company Name] Enter the company name of the recipient if necessary (using up to 80 char-
acters).

[Department] Enter the organization name of the recipient if necessary (using up to 
80 characters).

[ECM] Uncheck the ECM box to cancel the Error Correction Mode (ECM).
The ECM is an error correction mode defined by the ITU-T (International 
Telecommunication Union - Telecommunication Standardization Sector). If 
fax machines support the ECM, they check for fax data errors while com-
municating with each other. Image disturbances due to telephone line 
noise can be suppressed.
This machine uses the ECM based communication by default. However, if 
the noise is high, the communication may take a little longer than the com-
munication without using ECM checking.
If you need to shorten the communication time, cancel the ECM checking 
and send a fax.

[International Transmis-
sion Mode]

Select the [International Transmission Mode] check box to send a fax to a 
foreign country.
The Overseas TX Mode function reduces the transmission speed (the infor-
mation transfer speed) for sending a fax. This is useful when sending a fax 
to an area where the communication status is poor.

[V.34 Mode] Clear the [V.34 Mode] check box to release the V.34 protocol mode.
The V.34 protocol is used for Super G3 fax communication. This can short-
en the communication time and cut the communication cost because a 
single page of size-A4 document can be sent within approximately 3 sec-
onds.
This machine uses the V.34 protocol communication by default. This ma-
chine cannot use the Super G3 mode communication if this machine or the 
destination fax is not connected to the PBX line or if the fax line speed is 
limited. If so, cancel the V.34 mode communication.

[Select Group] When you add a recipient to the group, select this group check box. You 
can also add a recipient in multiple groups.
Once added, you can specify recipients by selecting their group (for broad-
casting). If you send faxes frequently to particular members, it will be useful 
to add them to a group.
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5 Click [OK].

The Phone Book is finished from editing. When you are creating a Phone Book, go to Step 6.

6 Click [Yes].

7 Specify the storage location, enter the file name, then click [Save].

% The [Save As] screen is opened when you save the Phone Book for the first time. When you change 
the Phone Book for the second or other times, the [Save As] screen is not opened but the Phone 
Book file is overwritten with your changes automatically.

The Phone Book is saved as a file (in CSV format).

Tips
- The saved phone book file automatically appears when you open the phone book next time. To open 

another Phone Book file, open the [Phone Book Entry] screen, and select [Open] from the [File] menu. 
Saving multiple phone book files can switch between these files to locate the desired one.

- When you create a Phone Book file, open the [Phone Book Entry] screen and select [New] from the [File] 
menu. Also, you can save the file to have an alias by selecting [Save as...] from the [File] menu.

Search for destination

You can search for a recipient from the Recipients List registered in the Phone Book.

Part of recipient information or multiple conditions can be used for this search.

When you search for a recipient, click [Search...] from the Phone Book. Your operations are the same when 
you open the Phone Book to send a fax and when you open the Phone Book to add a recipient to it.

You can use the [Basic] search or [Advanced] search.
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The [Basic] search displays recipients which meet any of search conditions. Enter characters to search, then 
click [Search Now].

The [Advanced] search displays the recipient which matches all of search conditions. Select the [Search Item] 
and [Condition]. Then, enter characters to search, then click [Add Condition]. Specify multiple search condi-
tions if necessary, then click [Search Now].
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Edit the recipient information

You can have an easy to use Phone Book by customizing it. You can edit the recipient information, and edit 
and file the Phone Book. When you edit the Phone Book, use the Phone Book that you open when adding a 
recipient.
- When you edit the recipient information, select a recipient from the [Personal List], then click [Edit...].
- To delete a recipient from the Phone Book, select the recipient from the [Personal List], then click [De-

lete]. During this time, the recipient is also deleted from the registered group.

Tips
- If you directly enter a recipient name and fax number when sending a fax and if you register them by 

the [Register To Phone Book], the name and fax number are displayed in the [Simple Entry] folder.

Change the recipient group

When you change a group, use the Phone Book that you open when adding a recipient.

From the [Personal List], select a recipient that you wish to move to another group, and select the check box 
of the desired group number shown at the right of the screen.

Tips
- You can also register a recipient by dragging the name from the [Personal List] to a group. However, 

you cannot delete the recipient from the group by dragging the name.
- You can register up to 100 recipients to one group.
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Changing a group name

From the [Group] list on the left-hand side of the Phone Book, select a group you wish to rename and select 
[Rename Group...] from the [Edit] menu. Rename the group in the displayed screen.

Control the recipients using folders

You can control the recipients compositely by combining a folder and a group.

Select [Personal List], then click [Add Folder...] to create a folder. You can also select [Add Folder...] in the 
[Edit] menu to create a folder.
- You can move a recipient name from the [Personal List] to another folder by dragging it.
- To rename a folder, select it, then click [Edit...].
- To delete a folder, select it, then click [Delete].

Tips
- You can also move a recipient to another folder by selecting the [Copy] or [Cut] from the shortcut menu, 

and by selecting [Paste] to the desired folder.
- You can enter a folder name using up to 40 characters.
- You can create folders up to three hierarchy levels.
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5 Sending options

5.1 Send a fax with a cover sheet.

When you open the [FAX Transmission Popup] screen and select the [FAX Cover Sheet] check box, you can 
add a cover sheet to the fax when sending.

Tips
- You can edit the cover sheet data in the [FAX Cover Sheet Settings] screen, which is opened when you 

click [Settings...]. Also, you can set it in the [FAX] tab of the fax driver.
- If the PC is running on Windows Vista x64 or Windows Server 2008 x64, you cannot set the [FAX Cover 

Sheet] in the [FAX Transmission Popup] screen. In such a case, set the Fax cover sheet in the [FAX] tab 
of the fax driver in advance.

1 Open the [FAX Transmission Popup] screen, and select the [FAX Cover Sheet] check box.

2 Click [Settings...].

The [FAX Cover Sheet Settings] screen opens.

3 Select a size of cover sheet from the [Cover Size].
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4 Set a style and subject of the cover sheet in the [Basic] tab.

5 Open the [Recipient] tab, and select the [Standard] or [Details] format of destination.

Settings Description

[Style] Select a style of cover sheet.

[Subject] When you write a subject on the cover sheet, select this check box and en-
ter the subject (using up to 64 characters).

[Date] When you write the date on the cover sheet, select this check box and 
specify the date format.
• [Select Form]: Select a format of date.
• [Input Arbitrarily]: Enter a format of date (using up to 20 characters).

[Pages] When you write the total number of fax pages on the cover sheet, select 
this check box and select a number of fax pages including the cover sheet.

[Comment] When you send a comment to the destination, enter it using up to 640 char-
acters. (A New Line code is considered to be two characters long.)

Settings Description

[Standard] Use the standard characters to write the standard character string, which 
does not specify the recipient, on the cover sheet.

[Details] When you write the recipient information on the cover sheet, set a style.
To add a title to the recipient, add it when you set the recipient name in the 
[FAX Transmission Popup] screen.

[Load with Joint 
Name]

Enter the joint name of recipients which has been added to the [Recipient 
List] of [FAX Transmission Popup] screen.

[Change Each Recip-
ient]

This option changes the information written on the cover sheet for each re-
cipient. Enter the contents of [Recipient List] displayed in the [FAX Trans-
mission Popup] screen.
You can create different cover sheets for up to 100 recipients.

[Load Set Informa-
tion]

Enter the information you have set in the [Company Name], [Department], 
[Name], and [FAX Number] fields (using up to 80 characters for each entry).
You can select this option if a recipient has been added to the [Recipient 
List] of [FAX Transmission Popup] screen.
• When you click [Read], information of the first line of [Recipient List] of 

the [FAX Transmission Popup] screen is reflected.
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6 Enter the sender information in the [Sender] tab (using up to 80 characters for each entry).

7 To add an image, specify an image file in the [Image] tab.

% You can place images such as company's logo and map on the cover sheet. BMP format can be 
specified.

% Select the [Zoom] check box to zoom an image.
% Set a position to add an image, using [X:] and [Y:] options.

8 Check the layout image of cover sheet.

% Click [Check...] to enlarge and check the layout image.
% When you click [Add...], the cover sheet image is saved and you can recall it later by selecting [Cover 

Sheet Settings].

9 Click [OK].
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5.2 Sending a fax at preset time (Timer TX)

Timer Transmission

The Timer TX function can send a fax at the preset time if you have set a time in advance.

If you use the timer transmission during telephone rate discount time in early morning or late at night, you can 
cut the communication cost. You can send up to 20 faxes by timer transmission.

Tips
- When sending a fax using a timer, make sure that the time set in the computer matches that set in this 

machine. If the current time has already passed the Timer TX time, the fax is sent in the next day.

How to Send

1 From the [FAX Transmission Popup] screen, select [Fax Mode Setting Details...].

The [Fax Mode Details] screen opens.

2 Select the [Timer Send] check box, and set the [Send Time].

% When you click [Reflect Current Time], the current clock time of the PC is reflected on the [Send 
Time].

3 Click [OK].
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5.3 Sending a confidential fax (Confidential communication)

Confidential communication

The confidential communication function is designed for communications with specific people using a 
Confidential User Box that requires a registered number and a password.

This ensures fax communications are sent with enhanced security.

Tips
- The destination fax needs to have the F-code function.
- When sending a confidential fax, you need to check the recipient's Confidential User Box number and 

the password for confidential fax reception.

How to Send

1 From the [FAX Transmission Popup] screen, select [Fax Mode Setting Details...].

The [Fax Mode Details] screen opens.

2 Specify the recipient's Confidential User Box.

% [SUB Address]: Enter the Confidential User Box number of the recipient.
% [Sender ID]: Enter the password for the recipient's Confidential User Box.

3 Click [OK].
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5.4 Sending a fax via relay station (Relay Distribution)

Relay Distribution

The Relay Distribution function distributes a fax to the preset recipients using relay stations.

If you have grouped the relay stations and recipients by area, you can reduce the total communication cost 
than the broadcasting of fax to all destinations. This is useful for broadcasting to distant locations.

Tips
- The destination machine (the relay station) must have the F-code function.
- When using the relay distribution, you need to check both the number of the Relay User Box defined 

for the relay station and the password.

How to Send

1 From the [FAX Transmission Popup] screen, select [Fax Mode Setting Details...].

The [Fax Mode Details] screen opens.

2 Specify the recipient's Confidential User Box.

% [SUB Address]: Enter the Relay User Box number of the recipient.
% [Sender ID]: Enter the password for the recipient's Relay User Box.

3 Click [OK].
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5.5 Send a fax with authentication information.

Fax transmission for authentication setup

If user authentication and account track have already been employed, each user needs to send his/her au-
thentication information (the user name and password) to this machine when sending PC-Fax. This limits the 
users who can send PC-Fax via the machine and prevents unauthorized use by third parties.

When this machine receives a send job from a user who is not authorized to use this machine, or when this 
machine receives a send job that does not have any authentication information, this machine discards these 
jobs automatically.

Tips
- A send job that does not have any authentication information refers to a job whose user authentication 

or account track has not been set correctly in the [Configure] tab in the [Properties] screen of the fax 
driver.

Operations required to use this function

Open the [Configure] tab of the fax driver, and ensure that the user authentication or account track has been 
set correctly.

1 Open the [Properties] screen of the fax driver.

% For details on how to open the [Properties] screen, refer to page 6-3.

2 Open the [Configure] tab, and check the [Device Option] to ensure that the user authentication or ac-
count track has been set correctly according to the current operating environment.

% If it is not configured correctly, select [User Authentication] or [Account Track] from the list, then 
change the relevant setting in [Setting].

3 Click [OK].

OK!
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How to Send

1 In the [Basic] tab, click [Authentication/Account Track...].

2 When user authentication is enabled, select [Recipient User], then enter the user name and password.

% If access to this machine by public users (unregistered users) is allowed, you can select [Public User] 
and send a fax without entering the user name and password.

% When using an external authentication server, click [Server Setting...] and select the authentication 
server.

% If you always use the same user name and password, registering them in advance eliminates the 
need for entering them each time. For details, refer to page 2-8.

3 If account track is enabled, enter the account name and password.

% If you always use the same account name and password, registering them in advance eliminates 
the need for entering them each time. For details, refer to page 2-8.
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4 Click [OK].

% If the PC can communicate with this machine, you can click [Verify] to check the entered authenti-
cation information. Also, you can check the authentication information for errors before printing it.

5 Send a fax.

If the authentication information is correct, the fax is sent.
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6 Fax Driver Settings

6.1 The [Properties] screen of the fax driver

How to display the [Properties] screen

The fax driver has two screens for configuring settings: the [Properties] screen and the [Printing Preferences] 
screen. The following explains the [Properties] screen.

In the [Properties] screen, you can set the optional environment of this machine and Windows OS functions.

You can open the [Properties] screen as follows.

1 Display the printer screen.

% In Windows 7/Server 2008 R2, click the Start menu, then select [Devices and Printers].
If [Devices and Printers] is not displayed, select [Control Panel] - [Hardware and Sound], and click 
[View devices and printers].

% In Windows Vista/Server 2008, click the Start menu, and select [Control Panel] - [Hardware and 
Sound] - [Printer]. When [Control Panel] is displayed in Classic View, double-click [Printers].

% In Windows XP/Server 2003, click the Start menu, then select [Printers and Faxes]. 
If [Printers and Faxes] is not displayed, select [Control Panel] - [Printers and Other Hardware] - 
[Printers and Faxes]. When [Control Panel] is displayed in Classic View, double-click [Printers].

2 Open the printer properties.

% In Windows 7/Server 2008 R2, right-click the icon of the installed printer, and from [Printer proper-
ties], click the displayed printer name.

% In Windows XP/Vista/Server 2003/Server 2008, right-click the icon of the installed printer, then click 
[Properties].

The [Properties] screen appears.

Tabs provided by Windows

The [General], [Sharing], [Port], [Advanced], [Color management], and [Security] tabs are provided by Win-
dows.

You can print a test page, configure printer sharing, configure printer ports, etc. For details, refer to the Win-
dows manuals.
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In the [Configure] tab, you can register a method to obtain information about the installation status of optional 
devices on this machine as well as the information about this machine in the fax driver.

Settings Description

[Device Option] The model name, options installed on this machine, and authentication set-
tings of this machine are displayed.
When the settings of this machine cannot be obtained, you need to manu-
ally change the settings. Select an item to change from the list, and set a 
value in the [Setting].

[Obtain Device Information] The PC communicates with this machine and obtains the optional device 
installation information.
In [Obtain Settings...], set the method of obtaining the information on this 
machine.

[Obtain Settings...] Configure the settings to obtain the information of this machine.

[Automatic Retrieval 
Settings]

Select whether to obtain device information automatically.
• [Auto]: Select this check box to automatically obtain the information of 

this machine.
• [Do not retrieve in Sleep Mode]: Select this check box if you do not wish 

to release the sleep mode of the machine when automatically obtaining 
the device information from this machine. If the check box is selected, 
the device information is not obtained when this machine is in sleep 
mode.

[Destination Settings] Set the communication method to use to obtain information from this ma-
chine.
• [Device which Connect with Printer Port]: Information is obtained from 

the printing port specified in the [Port] tab in the fax driver.
• [Specify IP Address or Printer Name]: Information is obtained by con-

necting to a device with the entered IP address or printer name.

[Read Community 
Name]

Enter the Read Community Name used to obtain information from this ma-
chine if you have changed the SNMP Read Community Name on this ma-
chine.

[Enter Password to 
acquire Device Infor-
mation]

Enter the password for user authentication if the device information is 
password protected against access through the fax driver on this machine.

[Encryption Passphrase] Select this check box to set a unique encryption passphrase.
The encryption passphrase is used to cipher the authentication password 
when it is sent to this machine during fax transmission. Normally, the au-
thentication password is encrypted using the encryption passphrase reg-
istered in advance in this machine. However, you can change the 
encryption passphrase when necessary.
To change the encryption passphrase, change the settings of this machine, 
then enter the preset encryption passphrase for the fax driver. For details 
on how to change the encryption passphrase, refer to [User's Guide: Print 
Operations].
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Tips
- When [Auto] in [Obtain Settings...] is enabled and the computer is unable to communicate with this ma-

chine, the computer takes a long time to display the [Properties] screen or the [Printing Preferences] 
screen.

- If you are using the machine from a Windows XP/Server 2003 PC via USB connection, [Obtain Device 
Information] cannot be used.

Related setting (for the administrator)
- You can use a password to restrict the ability to obtain device information from the printer driver (de-

fault: [No]). For details, refer to [User's Guide: Print Operations]. 
To configure settings, select [Utility] - [Administrator Settings] - [Printer Settings] - [Assign Account to 
Acquire Device Info].
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6.3 Available Operations with the [Settings] Tab

In the [Settings] tab, you can change the default settings for how confirmation messages are displayed as 
well as the screen for inputting authentication information.

Settings Description

[Display Constraint Mes-
sage]

Select this check box to display a message indicating that you have select-
ed the fax driver functions that cannot be used together.

[Display paper set in Print 
Server Properties]

Select this check box when using the paper added in [Server Properties] in 
the printer screen.

[Reconfirm FAX number 
entered directly]

Select this check box if you enter the [FAX Number] directly in the [FAX 
Transmission Popup] screen and if you wish to confirm the fax number in 
the screen when you click [Add Recipients].
This is helpful to prevent a fax from being sent to an incorrect destination.

[Authentication Settings...] Configure the User Authentication/Account Track settings.
• [Verify Authentication settings before printing]: Select this check box to 

enable the [Verify] button in the [User Authentication/Account Track] di-
alog box.

• [Popup Authentication Dialog when printing]: Select this check box to 
display the [User Authentication/Account Track] dialog box when start-
ing printing. This option reminds you to enter the user name and pass-
word.

• [Do not allow changes to the [User Name]]: This option restricts chang-
es to [User Name] of [Recipient User] in the [User Authentication/Ac-
count Track] dialog box in the [Basic] tab.

• [Do not allow changes to the [Password]]: This option restricts changes 
to [Password] of [Recipient User] in the [User Authentication/Account 
Track] dialog box in the [Basic] tab.

[Save Custom Size...] When you send a document having the special size, select the size and 
register its papers.
The registered paper size can be selected from [Original Size] or [Paper 
Size] of the [Basic] tab.

[Setting Up LDAP...] If you are using the LDAP server or the Active Directory of Windows Server, 
you can register a server to search for recipients. The registered server is 
displayed in the Phone Book.
For details on how to register it, refer to page 6-8.
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Tips
- You can open the [Server Properties] screen as follows.
– If Windows 7 or Windows Server 2008 Revision 2 is running, select a printer, then click [Print Server 

Properties].
– If the Windows Vista or Windows Server 2008 is running, place the cursor pointer in an empty area of 

the [Printers] screen, then click the mouse right button. From the shortcut menu, select [Run as admin-
istrator] - [Server Properties].

– If the Windows XP or Windows Server 2003 is running, click the [File] menu and select [Server Proper-
ties].

- You can set the following types of papers in the Server Properties of the fax driver.
Custom sizes available in fax driver: 
Width: 3-9/16 to 12-5/8 inches (90.0 to 320.0 mm), Length: 5-1/2 to 18 inches (139.7 to 457.2 mm) 
Banner sizes available in fax driver: 
Width: 8-1/4 to 11-11/16 inches (210.0 to 297.0 mm), Length: 18 to 47-1/4 inches (457.3 to 1200.0 mm) 
Allowable range of large size 1: 
Width: 3-9/16 to 8-1/4 inches (90.0 to 209.0 mm), Length: 18 to 46-13/16 inches (457.3 to 1189.0 mm) 
Allowable range of large size 2: 
Width: 11-11/16 to 12-5/8 inches (297.1 to 320.0 mm), Length: 18 to 46-13/16 inches (457.3 to 
1189.0 mm) 
Allowable range of large size 3: 
Width: 12-5/8 to 33.11 inches (320.1 to 841.0 mm), Length: 5-1/2 to 46-13/16 inches (139.7 to 
1189.0 mm) 
The paper sizes registered in the range of the above custom sizes or banner sizes are available in both 
[Original Size] and [Paper Size] of the fax driver. However, the paper size registered in the allowable 
range of each large size is available only in [Original Size] of the fax driver.
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6.4 Register an LDAP server in the fax driver

If you are using the LDAP server or the Active Directory of Windows Server, you can register a server on the 
fax driver and you can search for a recipient on the server.

The following explains the server registration procedure in the fax driver.

1 Open the [Properties] screen of the fax driver.

% For details on how to open the [Properties] screen, refer to page 6-3.

2 Open the [Settings] tab, and select [Setting Up LDAP...].

3 Click [Add] and enter the LDAP server information, then click [OK].

Settings Description

[LDAP Server List] Lists the already registered LDAP servers.
• [Up]/[Down]: Moves the display position of the selected LDAP server.
• [Delete]: Deletes the selected LDAP server.

[Server Address] Enter the LDAP server address.

[LDAP Server Name] Enter an LDAP server name to be displayed in the [LDAP Server List].
Use names that can easily identify the servers.
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d Reference

For details on the destination search using LDAP server, refer to page 4-9.

[Connection] tab Sets an authentication type and the port for connection to the LDAP server.

[Authentication Type] Select the authentication type to log in the LDAP server.
Select the authentication type according to the LDAP server you are using.
If you have selected an option other than [Anonymous], enter the authenti-
cation information.

[Port Settings] Change the connection port number of the LDAP server if necessary.
Usually, you can use the default settings.
Select the [Use SSL] check box to use the SSL communication.

[Search] tab Set the search base and communication timeout when you use the LDAP 
search.

[Timeout(Second)] Change the timeout time of communication with LDAP server if necessary.

[Max.Search Results] Change the maximum number of destinations to be displayed as search 
results if necessary.

[Search Base] Specify the starting point when searching for a destination.

[Search Attributes] tab When you use the LDAP search, enter the attributes for the name, family 
name, given name, fax number, E-mail address, company name, and or-
ganization name.

Settings Description
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6.5 The [Printing Preferences] screen of the fax driver

How to open the [Printing Preferences] screen

The fax driver has two screens for configuring settings: the [Properties] screen and the [Printing Preferences] 
screen. The following explains the [Printing Preferences] screen.

The [Printing Preferences] window has multiple tabs on each of which related functions are grouped to enable 
you to configure print functions unique to this machine. To display the [Printing Preferences] window, take 
the following steps:

1 Display the printer screen.

% In Windows 7/Server 2008 R2, click the Start menu, then select [Devices and Printers].
If [Devices and Printers] is not displayed, select [Control Panel] - [Hardware and Sound], then click 
[View devices and printers].

% In Windows Vista/Server 2008, click the Start menu, and select [Control Panel] - [Hardware and 
Sound] - [Printer]. When [Control Panel] is displayed in Classic View, double-click [Printers].

% In Windows XP/Server 2003, click the Start menu, then select [Printers and Faxes]. 
If [Printers and Faxes] is not displayed, select [Control Panel] - [Printers and Other Hardware] - 
[Printers and Faxes]. When [Control Panel] is displayed in Classic View, double-click [Printers].

2 Open [Printing Preferences...].

% In Windows 7/Server 2008 R2, right-click the icon of the installed printer, and from [Printing Prefer-
ences...], click the displayed printer name.

% In Windows XP/Vista/Server 2003/Server 2008, right-click the icon of the installed printer, then click 
[Printing Preferences...].

The [Printing Preferences] screen is opened.

Tips
- The print settings changed here are registered as default values. To temporarily change settings when 

performing PC-FAX TX from the application software, click [Properties] (or [Detail Settings]) in the [Print] 
screen to open the [Printing Preferences] screen.
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Items common to each tab

The following explains the commonly used settings and buttons in each tab.

Settings Description

[Favorite Setting] You can register the current print settings as a favorite and recall it when 
sending a fax.
For details on the [Favorite Setting], refer to page 4-13.

View Displays the page layout sample with the current settings so that you can 
check the transmission fax image.

[Printer Information] Click this button to start Web Connection and check the printer informa-
tion. This button is enabled only when your computer can communicate 
with this machine.

[OK] Applies the current changes and closes the setup screen.

[Cancel] Discards (or cancels) the current changes and closes the setup screen.

[Help] Displays a help of each item of the screen.

[Default] Initializes the current settings.
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6.6 [FAX] tab options

Various fax transmission options can be set in the [FAX] tab.

Tips
- When you use the timer transmission, check that the clock time of the PC matches the clock time of 

this machine. If the clock time of this machine has already passed the specified send time, the fax is 
sent in the next day.

Settings Description

[Resolution] Set a resolution to send a fax. If the resolution is high, a large amount of 
information is scanned and the communication time increases.

[Print Recipient File] Select this check box to send a fax and print it at the same time.
You can also set this option in the [Fax Mode Setting Details...] of [FAX 
Transmission Popup] screen.

[Timer Send] Select this check box to set a time to send a fax. The fax is automatically 
sent at the specified time.
• [Reflect Current Time]: Reflects the current time of the PC onto the 

[Send Time].
You can also set this option in the [Fax Mode Setting Details...] of [FAX 
Transmission Popup] screen.

[SUB Address] When you use the F-code TX function, enter the box number for the desti-
nation box (using up to 20 digits).
You can also set this option in the [Fax Mode Setting Details...] of [FAX 
Transmission Popup] screen.

[Sender ID] When you use the F-code TX function, enter the password for the destina-
tion box (using up to 20 digits, with available symbols being # and *).
You can also set this option in the [Fax Mode Setting Details...] of [FAX 
Transmission Popup] screen.

[Cover Sheet] Select this check box to add a cover sheet to the fax when you send it. 
Click the [Settings] button to set up the cover sheet details.
You can also set this option in the [FAX Cover Sheet] of [FAX Transmission 
Popup] screen.

[Phone Book Entry...] Click this button to edit phone books.
For details, refer to page 4-15.
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6.7 Available Operations with the [Basic] Tab

In the [Basic] tab, you can set the original orientation and paper size. If user authentication or account track 
is employed on this machine, set the authentication information. 

Tips
- [12 e 18] in [Paper Size] is equivalent to 304.8 e 457.2 mm that is slightly larger than A3.
- In [Original Size], you can select A0, A1, A2, B1, B2, or B3. However, the original is reduced to the size 

specified in [Paper Size]. In this case, you cannot select [Same as Original Size] in [Paper Size]. 
Likewise, the large size registered in Print Server Properties is also reduced to the size specified in [Pa-
per Size]. The paper set in Print Server Properties is available when the [Display paper set in Print Server 
Properties] check box is selected in the [Default Settings] tab.

- Custom size documents may be reduced and printed on standard A4 size papers by the destination 
machine due to its limited performance.

Settings Description

[Original Orientation] Specify the orientation of the original created in application software.
If the setting in the fax driver differs from that specified in the application 
software, correct the setting.

[Original Size] Select the size of the original created in application software.
If the setting in the fax driver differs from that specified in the application 
software, correct the setting.
When scanning a custom-sized original, select [Custom Size] and set its 
width and length.

[Paper Size] Select a paper size of send a fax.
If this setting differs from the original size and [Zoom] is set to [Auto], the 
original is enlarged or reduced to the selected paper size.
When sending a custom-sized document, select [Custom Size] and set its 
width and length.

[Zoom] Select how the print image is enlarged or reduced.
• [Auto]: The image is enlarged or reduced to the size specified in [Paper 

Size].
• [Manual]: The image is enlarged or reduced by the specified ratio (25 to 

400%).

[Authentication/Account 
Track...]

When user authentication or account track is employed, enter the user 
name or account name and the password. For details, refer to page 5-9.
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6.8 Available Operations with the [Layout] Tab

In the [Layout] tab, you can configure layout settings for fax sending.

Settings Description

[Combination] Select how the original pages are combined on sheets.
• [2 in 1]/[4 in 1]/[6 in 1]/[9 in 1]/[16 in 1]: 

Multiple pages are reduced on the same side of one sheet for sending. 
For example, when you select [9 in 1], every set of nine pages is re-
duced on the same side of one sheet for sending.

• [2 e 2]/[3 e 3]/[4 e 4]: 
The original image is enlarged, divided and printed onto multiple 
sheets. For example, when you select [2 e 2], one page of the original 
is divided and printed onto four sheets. When you join the printed 
sheets, you will create a large poster.

As necessary, click [Combination Details...] to configure detailed settings 
about page combination.
• [Combination]: Select the page combination.
• [Layout Order]: When you have selected N in 1 in [Combination], select 

the order of pages in the layout.
• [Border]: When you have specified N in 1 in [Combination], select this 

check box if you want to draw border lines between pages. In addition, 
select the type of border lines.

• [Overlap width line]: When you have specified N e N in [Combination], 
select this check box if you want to create overlap margins.

[Skip Blank Pages] Select this check box to exclude blank pages in the original from the pages 
to be send.



d-Color MF552/452/362/282/222 6-15

6.9 Available Operations with the [Stamp/Composition] Tab 6

6.9 Available Operations with the [Stamp/Composition] Tab

In the [Stamp/Composition] tab, you can set the composition of the watermark on the original.

Settings Description

[Watermark] Select this check box to print a watermark (text stamp) on the original. Al-
so, select a watermark for composition from the list.
Click [Edit...] and you can enter and edit a watermark. For details, refer to 
[User's Guide: Print Operations].
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6.10 Available Operations with the [Quality] Tab

In the [Quality] tab, you can set a font process on the original when it is sent by fax.

Settings Description

[Font Settings] Specify how to process texts.
Select the type (bitmap or outline) of the fonts to be downloaded from the 
computer to this machine. Also specify whether to replace the TrueType 
fonts by printer fonts when sending by fax.



d-Color MF552/452/362/282/222 6-17

6.11 Available Operations with the [About] tab 6

6.11 Available Operations with the [About] tab

Open the [About] tab, and you can check the fax driver version.
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7 Delete the fax driver

Uninstall the fax driver software using the delete program

If you have installed the fax driver using the installer, the fax driver uninstallation function has been added to 
the driver.

0 You need to have the administrator privileges to perform this task.

1 From the Start menu, select the delete program.

% In the d-Color MF362/282/222 environment, open the Start menu, and click [All Programs] (or [Pro-
gram]) - [GENERIC] - [364Series (PS_PCL_FAX)] - [Uninstall Printer Driver].

% In the d-Color MF552/452 environment, open the Start menu, and click [All Programs] (or [Pro-
gram]) - [GENERIC] - [554Series (PS_PCL_FAX)] - [Uninstall Printer Driver].

2 Select the fax driver you wish to delete, then click [Uninstall].

% Follow the subsequent on-screen instructions.

3 If the dialog box prompting to restart the computer appears, click [OK].

Now, the fax driver has been deleted.

Delete the fax driver using the installer

If you have installed the fax driver using the installer, you can use the installer to delete the fax driver.

0 You need to have the administrator privileges to perform this task.

1 Insert the DVD-ROM into the DVD-ROM drive of the computer.

% Make sure that the installer starts, and then go to Step 2.
% If the installer does not start, open the printer driver folder on the DVD-ROM, double-click [Set-

up.exe], and then go to Step 3.

2 Click [Printer Install].

The printer driver installer starts.

3 Click [AGREE] in the license agreement window.

4 Select [Uninstall Printer Driver], then click [Next].

5 Select the fax driver you wish to delete, then click [Uninstall].

% Follow the subsequent on-screen instructions.

6 If a restart prompt appears, click [OK] to restart the PC.

Now, the fax driver has been deleted.

d Reference

For details on how to delete the fax driver manually, refer to [User's Guide: Print Operations].
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DIRECTIVE 2002/96/EC ON THE TREATMENT, COLLECTION, RECYCLING AND
DISPOSAL OF ELECTRIC AND ELECTRONIC DEVICES AND THEIR COMPONENTS

INFORMATION

1. FOR COUNTRIES IN THE EUROPEAN UNION (EU)

The disposal of electric and electronic devices as solid urban waste is strictly prohibited: it must be collected separately.

The dumping of these devices at unequipped and unauthorized places may have hazardous effects on health and the
environment.
Offenders will be subjected to the penalties and measures laid down by the law.

TO DISPOSE OF OUR DEVICES CORRECTLY:

a) Contact the Local Authorities, who will give you the practical information you need and the instructions for handling the
waste correctly, for example: location and times of the waste collection centres, etc.

b) When you purchase a new device of ours, give a used device similar to the one purchased to our dealer for disposal.

The crossed dustbin symbol on the device means that:

  - when it to be disposed of, the device is to be taken to the equipped waste collection centres and is to be
handled separately from urban waste;

  - The producer guarantees the activation of the treatment, collection, recycling and disposal procedures in 
accordance with Directive 2002/96/EC (and subsequent amendments).

2. FOR OTHER COUNTRIES (NOT IN THE EU)

The treatment, collection, recycling and disposal of electric and electronic devices will be carried out in accordance with the
laws in force in the country in question.

 



 

 

 N ° 12-114 

DICHIARAZIONE CE DI CONFORMITA' del COSTRUTTORE secondo ISO/IEC 17050 
MANUFACTURER’S CE DECLARATION of CONFORMITY according to ISO/IEC 17050 

            

OLIVETTI  S.p.A        Via Jervis, 77  -  IVREA (TO)  -  ITALY 
 

Dichiara sotto la sua responsabilita' che il prodotto:  

Declares under its sole responsibility that the product: 
 
  Categoria generale: Apparecchiature per la Tecnologia dell' Informazione 

  Equipment category: Information Technology Equipment 

  Tipo di apparecchiatura: Copiatrice Laser digitale Multifunzionale 

 Product type: Multifunctional Digital Laser Copier 

 Modello/Product name: d-Color MF222 

  Opzioni/Options: SP-501, DF-701, DF-624, PC-110, PC-210, PC-410, DK-510. DK-705, 

MK-730, FS-533, PK-519, JS-506, FS-534, SD-511, PK-520, WT-506, 

FK-511(2set max), UK-204, SC-508, AU-102, AU-201, MK-735, 

   EK-606, EK-607, KH-102, HT-509, MK-734, Key Counter Mount Kit 

1, Key Counter, Key Counter Mount Kit CF 
    
  è CONFORME alla Direttiva 1999/5/CE del 9 marzo 1999 
  is in compliance with directive 99/5/EC dated 9

th
 march 1999   

e soddisfa i requisiti essenziali di  Compatibilità  Elettromagnetica, Consumo Energetico e Sicurezza previsti 

dalle Direttive: 
and fulfills the essential requirements of  Electromagnetic  Compatibility,  Electrical Power Consumption and 
Electrical Safety as prescribed by the Directives: 

2004/108/CE del 15 Dicembre 2004; (EMC) 
2004/108/EC dated 15th December 2004; 

2009/125/CE del 21 Ottobre 2009; (ErP) 
2009/125/EC dated 21st October 2009; 

2006/95/CE del 12 Dicembre 2006; (LVD) 

2006/95/EC dated 12th December 2006; 
 

in quanto progettato e costruito in conformità alle seguenti Norme Armonizzate: 
since designed and manufactured in compliance with the following European Harmonized Standards: 

EN 55022:2010 (Limits and methods of measurements of radio interference characteristics of Information 

Technology Equipment) / Class B 

EN 61000-3-2:2006 + A1:2009 + A2:2009 (Electromagnetic Compatibility (EMC) - Part 3: Limits - Section 2: 

Limits for harmonic current emissions (equipment input current  16 A per phase) 

EN 61000-3-3:2008 (Electromagnetic Compatibility (EMC) - Part 3: Limits - Section 3: Limitation of voltage 

fluctuations and flicker in low voltage supply systems for equipment with rated current up to and including  

16A) 

EN 55024:2010 (Electromagnetic Compatibility – Information technology equipment – Immunity characteristics 

– Limits and methods of measurement) 

EN 62311:2008 (Assessment of electronic and electrical equipment related to human exposure restrictions for 

electromagnetic fields (0 Hz - 300 GHz)) 

EN 60950-1:2006 + A11:2009 + A1:2010 + A12:2011 (Safety of Information Technology Equipment, 

including electrical business equipment) 

EN 60825-1:2007 (Radiation Safety of laser products, equipment classification, requirements and user's guide) 

ES 203 021-1: V2.1.1, ES 203 021-2: V2.1.2, ES 203 021-3: V2.1.2 (Referred Voluntary Requirements) 

EG 201 120: V1.1.1, EG 201 121: V1.1.3 (Referred Voluntary Requirements) 

1275/2008/EC  
 
La conformità ai suddetti requisiti essenziali viene attestata mediante l'apposizione della Marcatura CE sul 
prodotto. 
Compliance with the above mentioned essential requirements is shown by affixing the CE marking on the product. 
 
 Ivrea, 18 Giugno 2012 
 Ivrea, 18rdJune 2012 
 
             Walter Fontani 

     Quality Director 

                Olivetti S.p.A. 
 Note: 1)  La Marcatura CE è stata apposta nel 2012 
 Notes: 1)  CE Marking has been affixed in 2012 
  2)  Il Sistema della Qualità è conforme alle norme serie UNI EN ISO 9000. 
  2)  The Quality System is in compliance with the UNI EN ISO 9000 series of Standards 
  

Olivetti S.p.A. - Via Jervis, 77 - 10015 Ivrea (To) - Italy - Tel +39 0125 7751 - Cap. Soc. € 53.000.000 R.E.A. 547040 - Cod. Fisc./P.IVA  e iscriz. al Reg. Imp. Di Torino 02298700010 
Società con unico azionista, Gruppo Telecom Italia - Direzione e coordinamento di Telecom Italia S.p.A. 
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DICHIARAZIONE CE DI CONFORMITA' del COSTRUTTORE secondo ISO/IEC 17050 
MANUFACTURER’S CE DECLARATION of CONFORMITY according to ISO/IEC 17050 

            

OLIVETTI  S.p.A        Via Jervis, 77  -  IVREA (TO)  -  ITALY 
 

Dichiara sotto la sua responsabilita' che i prodotti:  

Declares under its sole responsibility that the products: 
 
  Categoria generale: Apparecchiature per la Tecnologia dell' Informazione 

  Equipment category: Information Technology Equipment 

  Tipo di apparecchiatura: Copiatrice Laser digitale Multifunzionale 

 Product type: Multifunctional Digital Laser Copier 

 Modello/Product name: d-Color MF362, d-Color MF282 

  Opzioni/Options: SP-501, DF-701, DF-624, PC-110, PC-210, PC-410, DK-510. DK-705, 

MK-730, FS-533, PK-519, JS-506, FS-534, SD-511, PK-520, WT-506, 

FK-511(2set max), UK-204, SC-508, IC-414, VI-506, AU-102, AU-201, 

MK-735, EK-606, EK-607, KH-102, HT-509, MK-734, Key Counter, 

Key Counter Mount Kit 1, Key Counter Mount Kit CF 
    
  sono CONFORMI alla Direttiva 1999/5/CE del 9 marzo 1999 
  are in compliance with directive 99/5/EC dated 9

th
 march 1999   

e soddisfano i requisiti essenziali di  Compatibilità  Elettromagnetica, Consumo Energetico e Sicurezza previsti 

dalle Direttive: 
and fulfill the essential requirements of  Electromagnetic  Compatibility,  Electrical Power Consumption and 
Electrical Safety as prescribed by the Directives: 

2004/108/CE del 15 Dicembre 2004; (EMC) 
2004/108/EC dated 15th December 2004; 

2009/125/CE del 21 Ottobre 2009; (ErP) 
2009/125/EC dated 21st October 2009; 

2006/95/CE del 12 Dicembre 2006; (LVD) 

2006/95/EC dated 12th December 2006; 
 

in quanto progettati e costruiti in conformità alle seguenti Norme Armonizzate: 
since designed and manufactured in compliance with the following European Harmonized Standards: 

EN 55022:2010 (Limits and methods of measurements of radio interference characteristics of Information 

Technology Equipment) / Class B 

EN 61000-3-2:2006 + A1:2009 + A2:2009 (Electromagnetic Compatibility (EMC) - Part 3: Limits - Section 2: 

Limits for harmonic current emissions (equipment input current  16 A per phase) 

EN 61000-3-3:2008 (Electromagnetic Compatibility (EMC) - Part 3: Limits - Section 3: Limitation of voltage 

fluctuations and flicker in low voltage supply systems for equipment with rated current up to and including  

16A) 

EN 55024:2010 (Electromagnetic Compatibility – Information technology equipment – Immunity characteristics 

– Limits and methods of measurement) 

EN 62311:2008 (Assessment of electronic and electrical equipment related to human exposure restrictions for 

electromagnetic fields (0 Hz - 300 GHz)) 

EN 60950-1:2006 + A11:2009 + A1:2010 + A12:2011 (Safety of Information Technology Equipment, 

including electrical business equipment) 

EN 60825-1:2007 (Radiation Safety of laser products, equipment classification, requirements and user's guide) 

ES 203 021-1: V2.1.1, ES 203 021-2: V2.1.2, ES 203 021-3: V2.1.2 (Referred Voluntary Requirements) 

EG 201 120: V1.1.1, EG 201 121: V1.1.3 (Referred Voluntary Requirements) 

1275/2008/EC  
 
La conformità ai suddetti requisiti essenziali viene attestata mediante l'apposizione della Marcatura CE sul 
prodotto. 
Compliance with the above mentioned essential requirements is shown by affixing the CE marking on the product. 
 
 
 Ivrea, 18 Giugno 2012 
 Ivrea, 18rdJune 2012 
             Walter Fontani 

     Quality Director 

                Olivetti S.p.A. 
 
 Note: 1)  La Marcatura CE è stata apposta nel 2012 
 Notes: 1)  CE Marking has been affixed in 2012 
  2)  Il Sistema della Qualità è conforme alle norme serie UNI EN ISO 9000. 
  2)  The Quality System is in compliance with the UNI EN ISO 9000 series of Standards 
  

Olivetti S.p.A. - Via Jervis, 77 - 10015 Ivrea (To) - Italy - Tel +39 0125 7751 - Cap. Soc. € 53.000.000 R.E.A. 547040 - Cod. Fisc./P.IVA  e iscriz. al Reg. Imp. Di Torino 02298700010 
Società con unico azionista, Gruppo Telecom Italia - Direzione e coordinamento di Telecom Italia S.p.A. 

 



 

 

 N ° 12-116 

DICHIARAZIONE CE DI CONFORMITA' del COSTRUTTORE secondo ISO/IEC 17050 
MANUFACTURER’S CE DECLARATION of CONFORMITY according to ISO/IEC 17050 

            

OLIVETTI  S.p.A        Via Jervis, 77  -  IVREA (TO)  -  ITALY 
 

Dichiara sotto la sua responsabilita' che il prodotto:  

Declares under its sole responsibility that the product: 
 
  Categoria generale: Apparecchiature per la Tecnologia dell' Informazione 

  Equipment category: Information Technology Equipment 

  Tipo di apparecchiatura: Copiatrice Laser digitale Multifunzionale 

 Product type: Multifunctional Digital Laser Copier 

 Modello/Product name: d-Color MF452 

  Opzioni/Options: SP-501, DF-701, PC-110, PC-210, PC-410, DK-510. DK-705, LU-204, 

LU-301, MK-730, FS-533, PK-519, JS-506, FS-534, SD-511, PK-520, 

WT-506, FK-511(2set max), UK-204, SC-508, IC-414, VI-506, AU-102, 

AU-201, MK-735, EK-606, EK-607, KH-102, HT-509, MK-734, 

   TK-101, Key Counter, Key Counter Mount Kit 1, Key Counter Mount 

Kit CF 
    

  è CONFORME alla Direttiva 1999/5/CE del 9 marzo 1999 
  is in compliance with directive 99/5/EC dated 9

th
 march 1999   

e soddisfa i requisiti essenziali di  Compatibilità  Elettromagnetica, Consumo Energetico e Sicurezza previsti 

dalle Direttive: 
and fulfills the essential requirements of  Electromagnetic  Compatibility,  Electrical Power Consumption and 
Electrical Safety as prescribed by the Directives: 

2004/108/CE del 15 Dicembre 2004; (EMC) 
2004/108/EC dated 15th December 2004; 

2009/125/CE del 21 Ottobre 2009; (ErP) 
2009/125/EC dated 21st October 2009; 

2006/95/CE del 12 Dicembre 2006; (LVD) 

2006/95/EC dated 12th December 2006; 
 

in quanto progettato e costruito in conformità alle seguenti Norme Armonizzate: 
since designed and manufactured in compliance with the following European Harmonized Standards: 

EN 55022:2010 (Limits and methods of measurements of radio interference characteristics of Information 

Technology Equipment) / Class B 

EN 61000-3-2:2006 + A1:2009 + A2:2009 (Electromagnetic Compatibility (EMC) - Part 3: Limits - Section 2: 

Limits for harmonic current emissions (equipment input current  16 A per phase) 

EN 61000-3-3:2008 (Electromagnetic Compatibility (EMC) - Part 3: Limits - Section 3: Limitation of voltage 

fluctuations and flicker in low voltage supply systems for equipment with rated current up to and including  

16A) 

EN 55024:2010 (Electromagnetic Compatibility – Information technology equipment – Immunity characteristics 

– Limits and methods of measurement) 

EN 62311:2008 (Assessment of electronic and electrical equipment related to human exposure restrictions for 

electromagnetic fields (0 Hz - 300 GHz)) 

EN 60950-1:2006 + A11:2009 + A1:2010 + A12:2011 (Safety of Information Technology Equipment, 

including electrical business equipment) 

EN 60825-1:2007 (Radiation Safety of laser products, equipment classification, requirements and user's guide) 

ES 203 021-1: V2.1.1, ES 203 021-2: V2.1.2, ES 203 021-3: V2.1.2 (Referred Voluntary Requirements) 

EG 201 120: V1.1.1, EG 201 121: V1.1.3 (Referred Voluntary Requirements) 

1275/2008/EC  
 
La conformità ai suddetti requisiti essenziali viene attestata mediante l'apposizione della Marcatura CE sul 
prodotto. 
Compliance with the above mentioned essential requirements is shown by affixing the CE marking on the product. 
 
 Ivrea, 18 Giugno 2012 
 Ivrea, 18rdJune 2012 
             Walter Fontani 

     Quality Director 

                Olivetti S.p.A. 
 Note: 1)  La Marcatura CE è stata apposta nel 2012 
 Notes: 1)  CE Marking has been affixed in 2012 
  2)  Il Sistema della Qualità è conforme alle norme serie UNI EN ISO 9000. 
  2)  The Quality System is in compliance with the UNI EN ISO 9000 series of Standards 
  

Olivetti S.p.A. - Via Jervis, 77 - 10015 Ivrea (To) - Italy - Tel +39 0125 7751 - Cap. Soc. € 53.000.000 R.E.A. 547040 - Cod. Fisc./P.IVA  e iscriz. al Reg. Imp. Di Torino 02298700010 
Società con unico azionista, Gruppo Telecom Italia - Direzione e coordinamento di Telecom Italia S.p.A. 

 



 

 

 N ° 12-117 

DICHIARAZIONE CE DI CONFORMITA' del COSTRUTTORE secondo ISO/IEC 17050 
MANUFACTURER’S CE DECLARATION of CONFORMITY according to ISO/IEC 17050 

            

OLIVETTI  S.p.A        Via Jervis, 77  -  IVREA (TO)  -  ITALY 
 

Dichiara sotto la sua responsabilita' che il prodotto:  

Declares under its sole responsibility that the product: 
 
  Categoria generale: Apparecchiature per la Tecnologia dell' Informazione 

  Equipment category: Information Technology Equipment 

  Tipo di apparecchiatura: Copiatrice Laser digitale Multifunzionale 

 Product type: Multifunctional Digital Laser Copier 

 Modello/Product name: d-Color MF552 

  Opzioni/Options: SP-501, DF-701, PC-110, PC-210, PC-410, DK-510. DK-705, LU-204, 

LU-301, MK-730, FS-533, PK-519, JS-506, FS-534, SD-511, PK-520, 

FS-535, SD-516, PK-521, JS-602, ZU-606, PI-505, WT-506, MK-735, 

FK-511(2set max), UK-204, SC-508, IC-414, VI-506, AU-102, AU-201,  

EK-606, EK-607, KH-102, HT-509, MK-734, TK-101, Key Counter, 

Key Counter Mount Kit 1, Key Counter Mount Kit CF 
    
  è CONFORME alla Direttiva 1999/5/CE del 9 marzo 1999 
  is in compliance with directive 99/5/EC dated 9

th
 march 1999   

e soddisfa i requisiti essenziali di  Compatibilità  Elettromagnetica, Consumo Energetico e Sicurezza previsti 

dalle Direttive: 
and fulfills the essential requirements of  Electromagnetic  Compatibility,  Electrical Power Consumption and 
Electrical Safety as prescribed by the Directives: 

2004/108/CE del 15 Dicembre 2004; (EMC) 
2004/108/EC dated 15th December 2004; 

2009/125/CE del 21 Ottobre 2009; (ErP) 
2009/125/EC dated 21st October 2009; 

2006/95/CE del 12 Dicembre 2006; (LVD) 

2006/95/EC dated 12th December 2006; 
 

in quanto progettato e costruito in conformità alle seguenti Norme Armonizzate: 
since designed and manufactured in compliance with the following European Harmonized Standards: 

EN 55022:2010 (Limits and methods of measurements of radio interference characteristics of Information 

Technology Equipment) / Class B 

EN 61000-3-2:2006 + A1:2009 + A2:2009 (Electromagnetic Compatibility (EMC) - Part 3: Limits - Section 2: 

Limits for harmonic current emissions (equipment input current  16 A per phase) 

EN 61000-3-3:2008 (Electromagnetic Compatibility (EMC) - Part 3: Limits - Section 3: Limitation of voltage 

fluctuations and flicker in low voltage supply systems for equipment with rated current up to and including  

16A) 

EN 55024:2010 (Electromagnetic Compatibility – Information technology equipment – Immunity characteristics 

– Limits and methods of measurement) 

EN 62311:2008 (Assessment of electronic and electrical equipment related to human exposure restrictions for 

electromagnetic fields (0 Hz - 300 GHz)) 

EN 60950-1:2006 + A11:2009 + A1:2010 + A12:2011 (Safety of Information Technology Equipment, 

including electrical business equipment) 

EN 60825-1:2007 (Radiation Safety of laser products, equipment classification, requirements and user's guide) 

ES 203 021-1: V2.1.1, ES 203 021-2: V2.1.2, ES 203 021-3: V2.1.2 (Referred Voluntary Requirements) 

EG 201 120: V1.1.1, EG 201 121: V1.1.3 (Referred Voluntary Requirements) 

1275/2008/EC  
 
La conformità ai suddetti requisiti essenziali viene attestata mediante l'apposizione della Marcatura CE sul 
prodotto. 
Compliance with the above mentioned essential requirements is shown by affixing the CE marking on the product. 
 
 Ivrea, 18 Giugno 2012 
 Ivrea, 18rdJune 2012 
             Walter Fontani 

     Quality Director 

                Olivetti S.p.A. 
 Note: 1)  La Marcatura CE è stata apposta nel 2012 
 Notes: 1)  CE Marking has been affixed in 2012 
  2)  Il Sistema della Qualità è conforme alle norme serie UNI EN ISO 9000. 
  2)  The Quality System is in compliance with the UNI EN ISO 9000 series of Standards 
  

Olivetti S.p.A. - Via Jervis, 77 - 10015 Ivrea (To) - Italy - Tel +39 0125 7751 - Cap. Soc. € 53.000.000 R.E.A. 547040 - Cod. Fisc./P.IVA  e iscriz. al Reg. Imp. Di Torino 02298700010 
Società con unico azionista, Gruppo Telecom Italia - Direzione e coordinamento di Telecom Italia S.p.A. 
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